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- محتویات بسته۱
Mini MKII_LCپروگرامر •

 (به منظور پایین نگاه داشتن قیمت نهایی، این کابل ارائه نمی شود. اتصال پروگرامر به میکروکنترلرISP  کابل•
این کابل تنها زمانی نیاز است که مایل به استفاده از زیف سوکت موجود بر روی پروگرامر نباشید)

 (به منظور پایین نگاه داشتن قیمت نهایی، این کابل ارائه نمی شZZود. اتصال پروگرامر به کامپیوترUSBکابل •
Microشما می توانید از هر کابل نZوع   USBمندZراه هوشZای همZارژ تلفن هZا شZا و یZل دیتZه کابZZاز جمل 

اندرویدی استفاده نمایید)
(به منظور پایین نگاه داشتن قیمت نهZایی، ایZن کابZل ارائه نمی شZود. آخریZن نسZخه از لوح فشرده نرم افزار•

نرم افزار اتمل استودیو و یا فلیپ، به رایگان از وب سایت شرکت اتمل قابل دانلZZود می باشZZد. نرم افزارهZZایی از
قبیل کدویژن و بسکام نیز بر روی وب سایتهای دانلود ایرانی موجود بوده و به راحتی قابل دریافت می باشد)

 اقلم حذف شده، به صورت جداگانه قابل سفارش و خرید از تولید کننده می باشند.تذکر:
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Mini MKII_LC- مشخصات پروگرامر ۲

.ISP- دارای واسط  
- بدون نیاز به منبع تغذیه مجزا

.ISP Rescue Clock- دارای قابلیت 
- تنظیم نرم افزاری سرعت پروگرام کردن.

.DIP- دارای زیف سوکت برای میکروهای 
.USB- اتصال به کامپیوتر از طریق پورت  استاندارد یو اس بی 

- قابلیت به روز رسانی پروگرامر به منظور پشتیبانی از میکروهای جدید.
.BASCOM-AVR , CodeVisionAVR, ATMEL Studio- شناسایی پروگرامر توسط نرم افزارهایی از قبیل 

)، و توزیع های مختلف لینوکس 64bit,32( و،XP و 7 و 8و 10 و تمامی سیستم عامل های  رایج  ویندوزPC , Laptop- سازگار با انواع 
.mega , tiny , 90s پروگرام می شوند شامل میکروهای SPI که به صورت AVR- پروگرام تمامی میکروکنترلرهای 

- تامین ولتاژ مورد نیاز میکرو در هنگام پروگرام کردن در صورت نیاز.
.FLASH , EEPROM- برنامه ریزی حافظه های 

 سانتی متر.7.5x4cm- ابعاد کوچک 
- امکان برنامه ریزی تمامی فیوزبیتها.

- محافظت در برابر اتصال کوتاه.
.USB1.1 ,USB2.0- سازگار با 

 ولت.5- ولتاژ پروگرام کردن: 

Key Features
• Short-circuit protection

• Programming voltage: 5V

• Target interface protection

• Programs both flash and EEPROM

• Upgradeable for future device support

• USB 2.0 compliant (full speed, 12Mbps)

• Supports fuses and lock bit programming

• 4MHz ISP Rescue Clock (for mis-set fuses)

• Powered from USB, does not require external power supply

• Adjustable ISP programming speed (50Hz to 8MHz SCK frequency)
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- اجزاء پروگرامر۳

 برای اتصال پروگرامر به پورت یو اس بی کامپیوتر.Micro USBکانکتور )1
 با دو عملکرد متفاوت (توضیحات بیشتر در بخش های بعد):S1کلید فشاری )۲

 بروزرسانی پروگرامر (وقتی جامپرJ1.(سرجای خود قرار داشته باشد 
 تغییر مد عملیاتی پروگرامر (وقتی جامپرJ1.(از سرجای خود برداشته شود 

 را تعیین می کند.S1 که نقش کلید J1جامپر )۳
 برای پروگرام کردن میکروهایی که بر روی زیف سوکت قرار نمی گیرند.ISP ۲×۳باکس هدر استاندارد )۴
 (توضیحات بیشترRescue Clock مگاهرتز به منظور استفاده به عنوان ۴ دارای پالس ساعت CLKاتصال )5

).5.5در بخش 
). این کلید می تواند در دو وضعیت مختلفPower Select (کلید کشویی انتخاب تغذیه ی میکروکنترلر)۶

قرار گیرد:
USB  POWER: انکتورZZبا کشیدن این سوئیچ به سمت چپ (به سمت ک USB انگرZZنش (USBنZZروش 

 از پروگرامر تامین شده و نیازی به منبZZع۴شده و ولتاژ تغذیه میکروکنترلر متصل به باکس هدر شماره 
 ولت می باشد.VCC = 5تغذیۀ جداگانه برای روشن کردن میکروکنترلر نیست. این ولتاژ برابر 

TARGET  POWER انگرZZبا قرار گرفتن کلید در سمت راست و خاموش شدن نش :USBعZZد از منبZZبای ،
 استفاده شود.۴ ولت برای روشن کردن میکروکنترلر متصل به باکس هدر شماره 5تغذیه جداگانه ی 

@avr_mkii                                                             4

1

2 3 4 5 6

891011

7



 Mini MKII_LC Programmer User Manual V0.9                                       MkII_LC  دفترچه راهنمای پروگرامر 

 کامپیوتر، به پایه ی شماره یUSB ولت پورت 5 عملکرد این کلید در  واقع قطع یا وصل نمودن ولتاژ تذکر:
 می باشد. به عبارت دیگZZر، ایZن کلیZZد هیZZچ تZأثیری بZZر روی ولتZZاژ اعمZZالی بZZه پایه هZZایISP باکس هدر ۲

زیف سوکت نداشته و ولتاژ تغذیه ی میکروی قرار داده شده بر روی زیف سوکت، فارغ از وضعیت ایZZن کلیZZد،
همیشه از پورت یو اس بی تأمین می گردد و قابل تغییر توسط کاربر نیست.

 پایه (نحZZوه ی قZZرار دادن انZZواع میکZZرو، در۴۰ پایه تا ۸زیف سوکت برای پروگرام کردن میکروهای دیپ از)۷
قسمت پایین پروگرامر ترسیم شده است).

 مگاهرتز موجود بر روی پروگرامر، از پایه هZای زیZZف۴ برای قطع و وصل نمودن اتصال کریستال 2Jجامپر )۸
).5.5سوکت (توضیحات بیشتر در بخش 

انتخاب منبع تغذیه میکروکنترلر. اگر این نشانگر روشن باشد تغذیه ی میکZZروی متصZZل بZZه:  آبینشانگر)۹
، از پروگرامر تامین می شود.۴باکس هدر شماره ی 

مشغول به کار بودن پروگرامر. پروگرامر در حال پروگرام کردن میکرو و یا تبZZادل داده بZZا:  قرمزنشانگر )1۰
کامپیوتر می باشد.

 روشن بودن و آماده به کار بودن پروگرامر را نشان می دهد.: سبزنشانگر)11

 بیتی دارای این پروتکل8 های AVR برای پروگرام کردن ISPنمای باکس هدر  استاندارد  

ISP نحوۀ اتصال کانکتور
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- راه اندازی پروگرامر۴

 نصب۱.۴

 بر روی سیستم نصبAtmel Studio یا AVR Studioبرای شناسایی پروگرامر توسط کامپیوتر باید نرم افزار 
شده باشد. در این صورت با اتصال پروگرامر به کامپیوتر و انجام مراحل نصب، درایورهای مربوطه نصب شده و آمZZاده

 کلیZZکاین لینZZککار می شود. (به منظور دریافت رایگان آخرین نسخۀ این نرم افزار از سایت شرکت  اتمZZل، بZZر روی 
کنید.)

Windows 8 نصب تحت سیستم عامل ویندوز  ۲.۴

 تنظیمات امنیتی به گونه ای اسZZت کZZه امکZZان نصZZب درایورهZZای ثبZZت نشZZده در1۰ و یا 8در سیستم عامل ویندوز 
AVRمایکروسافت وجود ندارد. از این رو در هنگام نصZZب برنامZZۀ   StudioبZZر نصZZه پروگرامZZوط بZZای مربZZدرایوره 

نخواهند شد. برای رفع این محدودیت و مشکل، پیش از نصب این برنامه مراحل زیر را به ترتیZZب انجZZام دهیZZد. (در
حالی که پروگرامر به کامپیوتر متصل نباشد.)

) نشZZانگر مZZاوس را در گوشZZۀ سZZمت راسZZت و پZZایین1
صفحه نمایش قرار دهید تا نZZوار عمZZودی سZZمت راسZZت

Settingsصفحه باز شود. در ایZZن نZZوار بZZر روی گزینZZۀ 

کلیک کنید.

 را کلیک کرده، در قسمت راست پنجره به انتهای پایین پنجره رفته و دکمZZۀGeneralرۀ باز شده گزینۀ ) از پنج2
Restart now.را فشار دهید 
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را انتخاب کنید. Troubleshoot) گزینۀ 3

را. Advanced options) و اکنون گزینۀ 4

 انتخاب گردد. Startup Settingsرۀ بعد هم ) از پنج5
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 کZZامپیوتر Restart) در مرحلۀ بعد با فشردن دکمZZۀ 6
شما مجددا  راه اندازی می شود.

 را فشار دهید تا گزینۀ7) پس از راه اندازی مجدد سیستم و نمایش صفحۀ زیر، از اعداد صفحه کلید عدد 7
“Disable driver signature enforcement”.انتخاب شود 

 را نصب کنید. و مطمئن شوید که در طول مراحل نصب اگر در موردAtmel Studio یا AVR Studio) اکنون 8
اب شده باشد. انتخInstall/upgrade USB Driverنصب درایور سؤال شد، گزینۀ 

) اگر طی مراحل نصب  این نرم افزارها، از طرف سیستم9
عامZZل وینZZدوز سZZؤالی در مZZورد تأییZZد نصZZب درایورهZZا

گزینۀ  شد،  Install this driver software”پرسیده 

anyway”.را انتخاب نمایید 
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- استفاده از پروگرامر۵

Atmel Studio استفاده در محیط  ۱.۵

AVR برای استفاده از پروگرامر در محیط  Studioبه منوی 

Tools → AVR Programming

AVRISPرفته و گزینه   mkII را برای Tool .انتخاب کنید DeviceرارZZه قZZد کZZهم باید نام میکروکنترلری باش 
است پروگرام شود.

، نرم افزار کنترل پروگرامر را به دست  گرفته و آماده پروگرام کردن میکروکنترلر مZZوردApplyحال با فشردن دکمه 
نظر می شود.

SPIتغییر سرعت پروگرام کردن در حالت 
(این مقدار باید کمتر از یک چهارم سرعت کلک  میکرو باشد)
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مشخصات میکروی مورد نظر

صفحۀ مربوط به تغییر مقادیر فیوز بیت ها
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CodeVisionAVRبه کارگیری در محیط   ۲.۵

 توصیه می شود به منظور مواجهه ی هرچه کمتر با مشکلت مربZوط بZه نصZب و سZZازگاری نرم افزارهZای اتمZلتذکر:
 و۷، از آخریZZن نسZZخه ی آن هZZا (هم اکنZZون: اتمل اسZZتودو 1۰استودیو و کدویژن، و نیز بسکام، مخصوصا  در وینZZدوز 

) استفاده شود.۳کدویژن 
) به آن اشاره شده است، بZZرای اسZZتفاده از پروگرامZZر در محیZZط کZZد ویZZژن، بایZZد۴.5بنابر دلیلی که در بخش بعد (

استفاده v2.xx نیز نصب شوند، بدین صورت که اگر از کد ویژن نسخه Atmel Studio یا AVR Studioنرم افزار 
AVRمی کنید، لزم است که   Studio نسخه v4.xx − − 4.18 ترجیحا  نسخۀ    هم روی سیستم نصب باشZZد 

v  را هم نصب کنید ولی کد ویژن به آنها نیازی ندارد). و اگر از کد ویژن نسخه6 یا 5(می توانید علوه بر آن، نسخه 
3.xx استفاده می کنید، نصب Atmel Studio نسخه v6.xx یا v7.xx  نیست.4کافی است و نیازی به نسخه 
 می توانید لیست کاملی از نسخه های مختلف اتمل استودیو را مشاهده، و نسخۀ مورد نظر را دانلود کنید. این لینکاز

اگر نصب موارد بال انجام نشود، هنگامی که در کد ویژن برای پروگرام کردن میکرو تلش کنید، با خطائی شZZبیه بZZه
شکل زیر مواجه خواهید شد:

 به آدرس زیر رفته:CodeVisionAVRپس از نصب موارد بال، در محیط کامپایلر 
Settings → Programmer  

 تغییر دهید.ATMEL AVRISP MkII - USB  را به AVR Chip Programmer Typeو مقدار 
اکنون می توانید در کد ویژن از پروگرامر استفاده کنید.
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AVR کد ویژن استفاده می نمایید و به دلیلی از قبیل کمبود حافظۀ کامپیوتر مایZZل بZZه نصZZب v2.xxاگر از نسخه 
Studio نسخۀ v4.xx علوه بر Atmel Studio  نیستید، روشی وجود دارد که توسط آن می توانید6 یا 5نسخه 

 استودیو هنZZوز هZZم6 یا 5 باشد (نسخه 4 بهره برید بدون آنکه نیازی به نصب استودیوی 2از پروگرامر در کد ویژن 
باید نصب باشد). برای استفاده از این روش، به طریق زیر عمل نمایید:

در محیط کد ویژن به آدرس زیر رفته،
Project → Configure → After Build → Program Settings

۴.5و مقادیر مربوطه را به شکل زیر تغییر دهید (اطلعات بیشتر در مZZورد ایZZن پارامترهZZا، در بخZZش بعZZدی یعنZZی 
موجود می باشد):

 را تایپ کنید.atprogram.exe آدرس فایل Program Directory and FileNameدر خانۀ 
به عنوان مثال:

C:\Program Files\Atmel\Atmel Studio 6.1\atbackend\atprogram.exe
 نیز خط زیر را قرار دهید:Command Line Parametersدر خانۀ دوم یعنی 

-t avrispmk2 -i isp -d MICRO program -fl -f “FILE_ADDRESS”
 را نیز به آدرس فایلی که قرارFILE_ADDRESS را به نام میکروی مورد نظر تغییر داده، و مقدار MICROو مقدار 

است بر روی حافظۀ میکرو ریخته شود تغییر دهید (فایلهای هگزی را که کد ویژن تولید می کند، در پوشه ای به نZZام
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Exe ام8 در داخل پوشۀ پروژۀ مورد نظر قرار دارد). مثل اگر میکروی ما یک میکروی مگاZZباشد و فایل هگز نیز با ن 
test در دایرکتوری D:قرار گرفته باشد، خط بال به صورت زیر در خواهد آمد 

-t avrispmk2 -i isp -d atmega8 program -fl -f “D:\test.hex”
) مراجعه شود.۴.5به منظور کسب اطلعات بیشتر پیرامون این پارامترها، به بخش (

Execute User's Program غیر فعال، و گزینۀ Program the Chipعلوه بر این، مطمئن شوید که گزینۀ 
فعال باشد.

)، پنجره ای باز می شZZودCTRL+F9اکنون هر بار که پروژۀ خود را در کد ویژن کامپایل می کنید (با کلیدهای میانبر 
که اطلعات مربوط به کامپایل در آن نمایش داده شده، و اگر برنامه خطایی نداشته و بطور کامل کامپایل شZZود، در

پایین پنجرۀ مذکور دکمه ای نشان داده می شود که با فشردن آن میکروی مورد نظر پروگرام می شود. 

لزم به ذکر است که با فشردن این دکمه، یک پنجرۀ خط فرمان به مدت کسری از ثانیه و یا در طولنی ترین حZZالت
فقط چند ثانیه باز شده، میکرو را پروگرام کرده، و سپس به طور خودکار بسته می شود. بنابراین امکان دیدن مراحل

پروگرامینگ و اینکه آیا عملیات پروگرام کردن به طور کامل و صحیح انجام گرفته یا نه، وجود ندارد

همان طور که در ابتدای این بخش گفته شد، درصورتی که آخرین نسZZخه از نرم افزارهZZای مZZورد نیZZاز خZZود را نصZZب
نمایید، بسیاری از مشکلت مربوط به عدم همخوانی این نرم افزارها با یکدیگر، به صورت خودکار برطرف شده و تنهZZا
با نصب اتمل استودیو و سپس کدویژن، و انتخاب صحیح نZZام پروگرامZZر از قسZZمت تنظیمZZات کZZدویژن، بZZه راحZZتی
می توانید شروع به کار با پروگرامر نمایید. این مطلب در مZZورد اسZZتفاده از پروگرامZZر در محیZZط بسZZکام نیZZز صZZدق

می کند.
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BASCOM-AVRبه کارگیری در محیط   ۳.۵

AVRپیش از آماده سازی پروگرامر بZرای کZZار در محیZZط بسZکام، بایZZد پروگرامZر در محیZZط   Studio اZZی Atmel
Studio .شناسایی شده و بتوان به آن متصل شده و پروگرام نمود 

.پیش از ادامۀ کار لزم است این مشکل برطرف شوددر غیر این صورت، 
 کار خواهد کرد که در نرم افزار اصلی خود قابل استفاده باشد!BASCOMپروگرامر تنها زمانی در محیط 

 ویندوز هم قابل بررسی است.device managerاین مطلب در قسمت 
right click Computer → manage → device manager

USB از آن برای اتصال به پروگرامرهای Atmel Studioدر تصویر بال می توان مشاهده نمود که درایور جانگو که 
 برای شناساندن پروگرامر به کامپیوتر، نصب شده اند.AVRISP mkIIاستفاده می کند، و نیز درایور  

AVRبا نصب   Studio یا ATMEL  StudioۀZZبه همراه درایورهای مربوطه (گزینۀ نصب درایورها در ابتدای مرحل 
 به طZZور خودکZZار نصZZب می شZZوند؛ و عبZZارتWinDriver و JUNGOنصب این نرم افزارهZZا انتخZZاب شZZده باشZZد)، 

AVRISP mkII.تنها زمانی در زیر جانگو اضافه می شود که پروگرامر به کامپیوتر وصل باشد 

پیش از نصب درایورهای سخت افزاری مورد نیاز بسکام کZZه تنهZZا یZک بZZار انجZZام می شZZود، لزم اسZZت پروگرامZZر در
 راS1 را از جای خود خارج نمZZوده و سZZپس کلیZZد J1وضعیت کاری  سازگار با بسکام قرار گیرد. بدین منظور جامپر 

 مرتبه چشمک خواهند زد که نشان دهنده ی قرار گرفتن پروگرامر در5یک بار فشار دهید. حال چراغ های پروگرامر 
وضعیت سازگار با بسکام است. اکنون می توانید جامپر را در سرجای خود قرار دهید. درصورت نیاز به بازگشت به مد

 مرتبه چشZZمک۲سازگار با اتمل استودیو و کدویژن، مجددا  جامپر را درآورده و کلید را بفشارید تا چراغ ها به تعداد 
بزنند. پروگرامر به صورت پیش فرض در مد سازگار با اتمل استودیو به مشتریان تحویل داده می شود.
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 می باشد کZZه نرم افزارهZZای زیZZادی از جملZZهLIBUSBبه منظور کار با پروگرامر در محیط بسکام، نیاز به نصب درایور 
Atmel FLIP از آن بهره می برند. این درایور در دو مد Filter و DEVICEقابل نصب است. پس از نصب آن در مد 

فیلتر، پروگرامر توسط بسکام قابل شناسایی و استفاده خواهد بود.
restore ، یک نقطۀ بازگشت (LIBUSBبهتر است پیش از نصب درایور   point.ایجاد کنید (

 را جدا کنید. نیز واضح اسZZت کZZه نصZZبUSB، تمامی دستگاه های متصل به پورت USB  هنگام نصب درایور 
 متصل باشد، غیر ممکن خواهد بود.USBاین درایور از روی حافظۀ فلشی که به پورت 

.' LIBUSB' امکان پذیر بوده و بر روی لوح فشرده نیز موجود است این لینک  ازLIBUSBدانلود 
 را اجرا نمایید.libusb-win32-devel-filter-X.X.X.X.exeفایل 

این فایل یک فایل اجرایی قابل نصب بوده و برای نصب آن نیاز به یک حساب کاربری از نوع مدیر (ادمین) می باشد.
 می توانید از صحت نصب آن اطمینان حاصل کنید: LIBUSBپس از نصب

 Programبه پوشۀ   Files\LibUSB-Win32\bin رفته و فایل  testlibusb-win.exeرZZرا اجرا کنید. اگ 
LIBUSBاهZZدرست نصب شده باشد، پنجره ای باز می شود که نمایش دهندۀ تمامی دستگاه های متصل به درگ 

USB می باشد. اگر این فایل اجرا نشد، عملیات نصب را در مد سازگار با ویندوز XP انجام دهید (کلیک راست 
مذکور، و سپس اجرا). Windows XP (Service Pack 2) Compatibility modeروی فایل و انتخاب حالت 

-اگر  .testlibusb win exe.درست کار کند، می توانید به مرحلۀ بعدی که نصب فیلتر است وارد شوید  

پروگرامر را اگر به کامپیوتر وصل نیست متصل کنید.•
 اجرا کنید.BIN را از پوشۀ install-filter-win.exeبرنامۀ •
پنجرۀ زیر را مشاهده خواهید نمود:•

 را فشار دهید.Next  را انتخاب کرده و دکمۀ 'Install a device filter'گزینۀ 
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 را بزنید.Installپروگرامر را انتخاب کرده و دکمۀ 

پس از چند لحظه، پیام تأیید نصب نمایش داده می شود.

 قابل استفاده است. کافی است نام پروگرامر را از لیست پروگرامرهZZا انتخZZاب کZZرده، وBASCOMاکنون پروگرامر در 
 قرار دهید.100ms را برابر timeoutمقدار 

@avr_mkii                                                             16



 Mini MKII_LC Programmer User Manual V0.9                                       MkII_LC  دفترچه راهنمای پروگرامر 

BASCOM-AVR → Options → Programmer → USBprog Programmer / AVR ISP mkII
برای بال بردن سرعت پروگرام، می  توانید این مقدار را کاهش دهید. اما اگر با کاهش آن، در هنگام پروگرام کردن بZZا

 در همۀ شرایط مناسب بوده و عملیات پروگZZرام100msپیام خطا مواجه شدید، مقدارش را افزایش دهید. معمول  
بدون خطا انجام خواهد شد.

هرگاه بعد از انجام مراحل فوق مایل بودید مجددا  از پروگرامر در نرم افزار اتمل استودیو یZZا کZZدویژن اسZZتفاده تذکر:
 بار چشمک بزننZZد و۲ را یک بار فشار داده تا چراغ های پروگرامر S1 را درآورده، کلید J1نمایید، کافی است جامپر 

سپس جامپر را بر سرجای خود قرار دهید.

 روش کلی برای تغییر مد پروگرامر۱.۳.۵

درواقع اگر مراحل فوق یعنی نصب درایورهای سازگار با اتمل استودیو و نیZZز نصZZب درایورهZZای سZZازگار بZZا بسZZکام،
درایورها به درستی انجام گیرند، آنگاه روش کلی برای قرار دادن پروگرامZZر در وضZZعیت سZZازگار بZZا اتمZZل اسZZتودیو و

کدویژن، یا بسکام، همانی خواهد بود که در پاراگراف بال اشاره شد:
 چشZمک زدنZZد، پروگرامZر در بZار۲ و رها کردن آن؛ اگر چراغ ها S1، و یک بار فشار دادن دکمه J1درآوردن جامپر 
 قZZرار دارد. بعZZدبسکام چشمک زدند، پروگرامر در وضعیت سازگار با  بار5 است؛ اگر اتمل استودیووضعیت سازگار با 

از انجام این کار می توان جامپر را سر جای خود قرار داد.
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Command line utility (CLI)I -  بکار گیری پروگرامر در خط فرمان ویندوز  ۴.۵

    اگر مایل به استفاده از پروگرامر در محیط خط فرمان ویندوز نیستید، و مشکلی هZZم در اسZZتفاده از پروگرامZZر در
محیط نرم افزار کد ویژن ندارید، می توانید از خواندن این بخش صرف نظر کنید.

 از آنAtmel Studio و AVR Studioدر ابتدا توضیح مختصری در مورد ساختار و فرآیندی کZZه نرم افزارهZZای 
برای پروگرام کردن میکروها استفاده می کنند داده می شود.

 برای پروگرام کردن میکروها استفاده می شد.STK500.exe از ابزاری به نام AVR Studio نرم افزار 4    در نسخه
 به بعد این نرم افزار کZZه بZZا نZZام6این ابزار به طور خودکار همزمان با نصب برنامۀ اصلی، نصب می شود. اما در نسخۀ 

Atmel  Studio امZZه نZZری بZZارائه می شود دیگر خبری از این ابزار نیست. در عوض، ابزار دیگ atprogram.exe
جایگزین آن شده که تمامی عملیات پروگرامینگ برای میکروهای مختلف و پروگرامرهZZای متفZZاوت فقZZط از طریZZق
همین ابزار انجام می گیرد. این ابزار رابط گرافیکی نداشته و دسترسی به آن از طریق خط فرمان ویندوز و یZZا ایجZZاد

 که توسط خود کاربران نوشته می شود، امکان پذیر است.batchفایل های اجرایی 
 بZرای پروگZرام کZZردنSTK500 در نسZخه های  پZایین خZود از ابZزار CodeVisionAVR    نرم افزارهایی از قبیل 

 روی سیستم نصZZب باشZZد. امZZاAVR Studio از 4استفاده می کنند. بنابراین نیازمند آن می باشند که حتما نسخه 
) خZود را بZا نرم افZزار شZZرکت اتمZZل بZه روز کZZرده، و از ابZزار3نسخه های  بالتر این نرم افزارها (مثل کدویژن نسخۀ 

atprogram.exe   .هم می توانند استفاده کنند
    بنابراین توضیحاتی که در ادامۀ این فصل ارائه شده است برای کسانی سودمند است که بخواهند در محیط خZZط
فرمان ویندوز و بدون هیچ رابط کاربری گرافیکی میکروی خود را پروگرام کنند؛ و یا کسانی که بخواهند از نرم افZZزار

AVR از نرم افZZزار 4  برای پروگرامینگ استفاده نمایند، بدون آنکه احتیاجی به نصZZب نسZZخۀ v2.xxکدویژن نسخۀ 
Studio.باشد 

 

atprogram.با استفاده از  exeشما می توانید 
 را بر روی میکروی مورد نظر پروگرام کنید.elf ،  یا hex ، binفایلهای •
از صحت عملیات پروگرامینگ اطمینان حاصل کنید.•
عملیات خواندن، نوشتن، و پاک  کردن را بر روی حافظه های  مختلف میکرو انجام دهید.•
فیوز بیتها، قفل های  سخت افزاری، بیتهای امنیتی، صفحۀ کاربری، و امضاهای کاربری را تغییر دهید.•
 را بر روی میکرو پروگرام کنید. productionفایل های •
لیست از تمامی پروگرامرهای متصل به کامپیوتر را بدست آورید.•
نوع و سرعت پروتکل پروگرامینگ را تغییر دهید.•
 ، وEEPROM ، FLASH است کZZه حZاوی محتویZZات حافظه هZای elf نوع خاصی از فایلهای productionفایل 

)، و نیز فیوزبیتها و لک  بیتها، به صورت یک فایل واحد می باشد.XMEGAامضاهای کاربری (فقط در 
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برای دسترسی به این ابزار، به آدرس زیر بروید:

Start → All Programs → Atmel → Atmel Studio 6.x Command Prompt

 وینZZدوز اسZZت.Command Promptروش دیگر برای دسترسی به این برنامه، مستقیما  از طریق خط فرمان یZZا 
در آن نصب شده بروید و با استفاده از جعبۀ جستجوی Atmel Studio 6.xبدین منظور به پوشه ای که نرم افزار 

  بگردیZZد. ایZZنatprogram.exeویندوز که در گوشۀ سمت راست بالی پنجرۀ باز شده قرار دارد، به دنبال فایZZل 
:فایل معمول  در یکی از دو پوشۀ زیر قرار دارد

C:\Program Files\Atmel\Atmel Studio 6.X\avrdbg
C:\Program Files\Atmel\Atmel Studio 6.X\atbackend

 و بالتر،7سپس یک خط فرمان باز کنید. سریع ترین روش آن است که در خانۀ جستجوی منوی استارت ویندوز  
 را تایپ کنید:cmdعبارت 

در پنجرۀ باز شده، آدرس خط فرمان را به آدرسی که در مرحلۀ قبل بدست آورده اید تغییر دهید. به عنوان مثال:

C:\>cd \Program Files\Atmel\Atmel Studio 6.1\atbackend

 این برنامه را اجرا نمایید: atprogramو سپس با تایپ عبارت 
C:\Program Files\Atmel\Atmel Studio 6.1\atbackend> atprogram

@avr_mkii                                                             19



 Mini MKII_LC Programmer User Manual V0.9                                       MkII_LC  دفترچه راهنمای پروگرامر 

همان طور که در تصویر بال مشاهده می شود، با اجرای برنZZامه لیسZZتی از پارامترهZZا و نیZZز فرمان هZZایی را کZZه کZZاربر
می تواند بنابر نیاز خود تعیین کند، به همراه شرح مختصری دربارۀ هر یک از این پارامترها نشان داده می شوند. 

 را بZZه همZZراه نZZام پZZارامترhelpبرای بدست آوردن اطلعات کامل در مورد هر یک از این پارامترها و فرامین، کلمۀ 
مورد نظر تایپ کنید. به عنوان مثال با تایپ عبارت زیر توضیحات کامل دربارۀ آرگومان های مربوط به پروگرام کردن

میکرو نشان داده می شود.
> atprogram help program

در ادامه به بررسی پارامترهایی که تعیین آنها توسط کاربر ضروری است پرداخته، و پس از آن توضیحات مختصZZری
پیرامون پارامترهای مربوط به فرامین خواندن و نوشتن و پروگرام کردن ارائه می شود.

پارامترهای ضروری

عبارتند از: نام پروگرامر، پروتکل ارتباطی میان پروگرامر و میکرو، و نام میکروکنترلر.

 باشد.avrispmk2 باید برابر با MKII -): مقدار این پارامتر برای پروگرامر tنام پروگرامر (

 باشد.TPI ، و یا ISP، PDI می تواند یکی از سه پروتکل MKII -): این پارامتر برای پروگرامر iپروتکل ارتباطی (

 -): نام میکروئی که قرار است پروگرام شود.dنام میکروکنترلر (

 که به پروگرامر متصZZل اسZZت نمZZایش8به عنوان مثال با تایپ عبارت زیر در خط فرمان، اطلعات یک میکروی مگا 
  انجام می گیرد.infoداده می شود. این کار با استفاده از فرمان 

> atprogram -t avrispmk2 -i isp -d atmega8a info
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فرامین اجرائی

برخی فرمان هایی که بیشتر مورد استفاده قرار می گیرند عبارتند از:
chiperase, erase, info, program, verify

با توجه به اینکه نام هر یک از این فرامین گویای عملکرد آنها بوده، و علوه بر این در خط فرمZZان اطلعZZات کZZاملی
پیرامون هر یک از آنها می توان بدست آورد، لذا در ادامه فقط به بررسی فرمان پروگرامینگ پرداخته می شود.

programفرمان 

از این فرمان برای پروگرام کردن میکروی مورد نظر توسط فایلی کZZه قبل  کامپایZZل شZZده اسZZت، اسZZتفاده می شZZود.
آرگمان های ضروری این فرمان عبارتند از نام حافظه ای که قرار است پروگرام شود، و آدرس فایلی که قرار اسZZت بZZر

روی میکرو ریخته شود. در ادامه متداول ترین مقادیر این آرگمان ها نام برده می شوند.

) نام حافظۀ مورد نظر1
fl-.برای پروگرام کردن فلش داخلی میکرو یا همان حافظۀ اصلی میکرو 
ee- برای پروگرام کردن حافظۀ دائمی داده یا همان eeprom.

fs-.برای پروگرام کردن فیوز بیت های  میکرو 

lb-.برای پروگرام کردن لک  بیت ها یا همان قفل های  سخت افزاری میکرو 

، دومین آرگمانی است که لزم است مقZZدار آن تعییZZن شZZود. ایZZن آدرگمZZان آدرس فایZZل-)f) آدرس فایل (2
هگزی است که قرار است بر روی حافظۀ مورد نظر نوشته شود.

علوه بر آرگمان های ضروری بال، می توان از آرگمان های غیر ضروری دیگر نیز استفاده نمود. مثل بZZا اضZZافه نمZZودن
 پس از عملیات پروگرامینگ صحت عملیات بررسی شده تا از درستی آن اطمینان حاصل شود. و --verifyآرگمان

- باعث می شود که پیش از پروگرام کردن، کل محتویات میکرو پاک  شود.cیا افزودن آرگمان 

 قرار دارد  بZZر رویd که در دایرکتوری testبه عنوان مثال با وارد نمودن عبارت زیر در خط فرمان، محتویات فایل
 متصل به پروگرامر ریخته شده و سپس از صحت عملیات اطمینان حاصل می شود.8حافظۀ فلش میکروی مگا 

> atprogram -t avrispmk2 -i isp -d atmega8a program -fl --verify -f d:\test.hex

 قرار”...”) می باشد، کل آدرس را در بین دو کاراکتر Space اگر آدرس فایل هگز دارای کاراکتر فاصله (:تذکر
دهید. به عنوان مثال: 

> atprogram -t avrispmk2 -i isp -d atmega8a program -fl -f “d:\my folder\test.hex”

 نیز می توان به کمک فرامین متنی از پروگرامر استفاده نمود.AVRdudeعلوه بر روش فوق، در محیط نکته: 
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 ISP Rescue Clockاستفاده از کلک خارجی -   ۵.۵
 تنظیم می شودExternal Clock به اشتباه برروی AVRگاهی فیوزبیت مربوط به انتخاب منبع کلک  میکروهای 

و یا به دلیلی از قبیل قطع شدن اتصالت در حین پروگرام کردن، مقدار این فیوز بیتها در وضعیت نامشخصی قZZرار
می گیرد. در چنین شرایطی لزم است برای پروگرام کردن مجدد میکرو و تنظیم صZZحیح فیوزبیت هZZا از یZZک پZZالس

ساعت خارجی از قبیل سیگنال ژنراتور با دامنه ولتاژ مناسب استفاده گردد.
و دارا می باشد. از این پالس به 4MHz قابلیت تولید پالس ساعت مذکور را با فرکانس Mini MKII_LCپروگرامر 
 نام برده می شود.Recovery Clock یا Rescue Clock Sourceاصطلح 

XTAL1 در بالی پروگرامر مشخص شده است را بZZه پایZZۀ CLKبرای استفاده از این پالس ساعت، نقطه ای که با نام 
ISP نیز به جایی وصZZل نمی شZZود. فرکZZانس پروگرامینZZگ یZZا همZZان XTAL2میکروی مورد نظر متصل نمایید. پایۀ 

Clock 125) را نیز بر روی 9 (تصویر صفحۀkHz.تنظیم کنید 
 به پایه های میکروی مورد نظر شما کZZهJ2 مگاهرتز است که از طریق جامپر ۴ پروگرامر، دارای یک کریستال :تذکر

بر روی زیف سوکت قرار می دهید متصل می شود. اگر به هر دلیلی مایلید اتصZZال ایZZن کریسZZتال بZZا میکZZرو را قطZZع
 را از جای خود خارج کنید.J2نمایید، کافی است جامپر 

 برای پروگرام کردنExternal Clockو طبق این توضیحات، واضح است که اگر می خواهید بجای این کریستال، از 
 را ازCLK از جای خود، باید J2میکروی قرار داده شده بر روی زیف سوکت استفاده کنید، علوه بر درآوردن جامپر 

 میکروی روی زیف سوکت متصل کنید. این کار را می توانید از طریق متصZZلXTAL1طریق یک تکه سیم به پایه ی 
 انجام دهید.J2 به پایه ی سمت چپ جامپر CLKکردن 
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.  چند نکته و رفع مشکلت احتمالی۶ 

اگر وقتی که پروگرامر را به کامپیوتر متصل می کنید چراغ قرمز آن به طور مداوم روشن باقی بماند، نشانگر
آن است که درایورهای آن به درستی نصب نشده اند و سیسZZتم عامل هنZZوز پروگرامZZر را نمی شناسZZد. علZZت

 و یا نصب ناقص آن می باشد. معمول  با نصب کامل و مجددAVR Studioعمده این مشکل نیز عدم نصب 
این نرم افزار، مشکل مذکور برطرف می گردد. در غیر این صورت مشZZکل مربZZوط بZZه سیسZZتم عامل کZZامپیوتر

می باشد.
 بار پشت سر هم چشمک زدند، پروگرامر در مد سازگار با۲با اتصال پروگرامر به کامپیوتر، اگر چراغهای آن 

 بار متوالی چشمک زدند، در حالت سازگار با بسکام. به منظور تغییر و5اتمل استودیو و کدویژن است؛ و اگر 
 را یک بار بفشارید.S1 را درآورده و دکمه J1جابه جایی بین این دو مد عملیاتی، کافی است جامپر 

هZZت کZZانگر آن اسZZد، بیZZاقی مانZZاگر در هنگام پروگرام کردن، چراغ قرمز پروگرامر به مدت طولنی روشن ب
خطایی در پروگرام کردن پیش آمده است. در ایZZن حZZالت پروگرامZZر را از کZZامپیوتر جZZدا نمZZوده، برنZZامه را

ببندید و عملیات پروگرام را مجددا  از نو شروع نمایید.
 برای استفاده از پروگرامر در محیط نرم افزارAvrdude باید libusb.را نصب کنید 
 همان طور که در شکل بال تذکر داده شده، فرکانسISP  Clock انس کلکZZارم فرکZZباید کمتر از یک چه 

میکروی مورد نظر باشد.
 اگر پروگرامر قادر به اتصال و پروگرام کردن میکرو نباشد، آن قدر فرکانسISP ClockاZد تZZرا کاهش دهی 

پروگرامر بتواند به پروگرامر متصل شود.
 ل۸ (و یا 1۰در ویندوزZZتم عامل قابZZرای سیسZZر بZZاگر پس از نصب  صحیح اتمل استودیو، باز هم پروگرام (

شناسایی نبود  و چراغ قرمز روشن باقی ماند، مراحل نصب درایور را به روشی که به طور مختصر در ادامه به
آن اشاره می شود انجام دهید: 

device حZZذف و پZZاک  کZZردن تمZZامی درایورهZZای پروگرامZZر، از طریZZق   managerودنZZف نمZZ؛ متوق
BitLockerدZZای فاقZZب درایورهZZتیبانی از نصZZد:  پشZZدر صورت فعال بودن؛ راه اندازی مجدد ویندوز در م 

مجوز، از طریق انتخاب گزینه ی زیر، از پانل سمت راست ویندوز:
PC-Settings → Update/Recovery → Recovery → Extended Start

گزینه  انتخاب  نصب ؛start windows without driver sign check Zو  و  اتصالLIBUSBدانلود  ؛ 
؛ راه اندازی مجدد ویندوز. انتخاب نام پروگرامر از لیست؛ زدن دکمه تایید؛inf-wizard.exe اجرای پروگرامر؛

:نصب و راه اندازی و نیز استفاده از پروگرامر، بر روی انواع سیستم عامل ویندوز از جمله تذکر XP، 7، 8 ،و
 آزمایش شده و صحت عملکرد آن مورد تأیید قرار گرفته است. نیز، تمامی پروگرامرها پیش از ارسال به10

مشتریان و یا تحویل به نمایندگان فروش، حداقل یک بZZار مZZورد تسZZت قZZرار گرفته انZZد. لZZذا تولیZZد کننZZده
هیچ گونه مسئولیتی در قبال مسائل نرم افزاری کاربران و مشZکلت احتمZالی هنگZZام نصZZب درایZور برعهZZده

نخواهد گرفت و از ارایه ی راهنمایی های فراتر از آنچه در این دفترچه راهنما ذکر شده، معذور است.
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Firmware Update. به روز رسانی پروگرامر - ۷

 ب!!رDFU-Programmer و یا FLIPبه منظور به روز رسانی یا تغییر ثابت افزار یا همان فرم ور پروگرامر باید نرم افزار 
 توسعه داده شده، ب!رATMEL که توسط شرکت FLIPروی کامپیوتر شما نصب شده باشد. آخرین نسخه از نرم افزار 

 قرار داده شده است. در ادامه به چگونگی به روز رسانی پروگرامر توسط این نرم افزار می پردازیم: CDروی 

 (و یا برای دریافت فایل پروگرامر قابل دریافت استکانال تلگرامی یا سایتوب جدید ترین فایل  به روز رسانی از نکته:
بدون نیاز به اینترنت، نشانگر موس را بر روی آیکون زیر  قرار داده، و طبق دستور نشان داده شده عمل کنید).

Mini ثابت افزار پروگرامر  MKII_LC
.

 واقع در سمت چپ بالی پروگرامر را فشار دهید. با اینS1 در سر جای خود قرار دارد، دکمهJ1در حالی که جامپر 
کار هر سه چراغ پروگرامر خاموش شده و نشان دهنده آن است که پروگرام!!ر آم!!اده دری!!افت نس!!خه جدی!!د ف!!رم ور

می باشد، البته در صورتی که سیستم عامل نیز پروگرامر را در این وضعیت شناخته باشد:
Deviceبرای بررسی این موضوع در سیستم عامل ویندوز ب!!ه قس!!مت   Managerرفت!!ه و اگ!!ر پروگرام!!ر توس!!ط 

کامپیوتر شما شناخته نشده است یعنی با علمت اخطار زرد رنگ نشان داده شده، درایور مربوط به وض!!عیت ب!!ه روز
رسانی آن را طبق مراحل زیر نصب کنید.

 را انتخاب نمایید.Update Driver Software بر روی آن کلیک راست کرده و گزینه Device Managerدر 
 را انتخاب کنیدBrowse my computer for driver softwareره باز شده گزینه - از پنج

C:\Program Files\Atmel\Flip 3.4.7\usb- در پنجره باز شده آدرس روبه رو را وارد نمایید:              
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 بر روی سیستم شما متفاوت است آدرس بال را متناسب با آن تغییر دهید.FLIPاگر مکان نصب نرم افزار 
 عملیات نصب شروع شده و پس از چند لحظه درایور نصب شده و پروگرامر آم!!اده ب!!ه روزNext- با فشردن دکمه 

 خواهد بود.FLIPرسانی توسط نرم افزار 
اکنون مراحل کار را طبق تصاویر زیر انجام دهید:

 را اجرا نمایید.FLIPنرم افزار 
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Device  کلیک کنید و یا از منوی chipبر روی آیکون  → Select گزینه AT90USB162.را انتخاب کنید 

 را فشار دهید.OKدکمه 

 را انتخاب کرده و به پروگرامر متصل شوید.USB کلیک کنید و از منوی ظاهر شده گزینه USB cableبر روی آیکون 
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فایل فرم ور جدید را بارگذاری کنید:

File → LOAD HEX file یا منوی LOAD hex fileآیکون 

 را از صفحه اصلی نرم افزار فشار دهید.RUNسپس دکمه 

Startاکنون پروگرامر شما به روز رسانی شده است. دکمه   Applicationرا فشار دهید یا پروگرامر را ی!!ک ب!!ار از 
کامپیوتر جدا نموده و مجددا  متصل نمایید تا در وضعیت پروگرام کردن قرار گیرد.

ـــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــــ

شماره تماس

09138051704
09360023323

 Telegram
@avr_mkii
Web Site
www.avrmkii.tk
Technical Support
avrmkii@gmail.com

و اعمل لخرتك كأنكك توت غدا

.و براى آخرت خود چنان عمل نا كه گوئى فردا خواهى مرد
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